The purpose of this exercise is to use the design mode to add a Web site to the Communications tab and add a tab and objects to the Electronic Health Record (EHR).

Accessing Design Mode
Log on to the EHR.

Right-click on the top bar and select Design Mode.
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Click the Design drop-down menu and choose: Desktop Properties.
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	Change the color (if you want) on one of the bars or the font on your desktop.


Add the User Name to the EHR Title Bar
	EXAMPLE:
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	STEP 1:
	STEP 1:
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	Find the Caption Box and place your cursor beside the IHS•EHR.

	STEP 2:
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	STEP 2:
Type in the following code to add the users name to the EHR GUI Title Bar:

$(USER.NAME)

	
	


Add Facility Name to EHR Title Bar
	EXAMPLE:

[image: image7.emf]
	

	STEP 1:
[image: image8.emf]
	STEP 1:
In Caption Value field, insert your facility’s name into the EHR GUI Title Bar.


	
	


Adding Refresh Button
	EXAMPLE 1:
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	EXAMPLE 2: 
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	STEP 1:
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	STEP 1:
Click on Customize Menus to view the menu tree

	STEP 2:
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	STEP 2:

Find the Patient Header. You will see two other options under this tab (Details and Select).

This is where you are going to insert the Refresh button.

	STEP 3:
Click the [image: image13.png]


 sign at the top of the menu to insert a new button
	STEP 3:
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	STEP 4: 
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	STEP 4:
Use the [image: image16.png]


 [image: image17.png]


 to move the new button up and under the Patient Header

Use the [image: image18.png]


 to rename the button to Refresh.

	STEP 5: 
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	STEP 5:
Highlight the new Refresh button and click the [image: image20.png]


 to insert the following code: 

$(session.eventfirelocal,'REFRESH','')

Click OK and Apply to save the new feature. To test the new button, log out of Design Mode and test it.
If it works, log back into Design Mode and save it. See below for instructions on saving templates.


Adding Clear Button
	EXAMPLE 1:
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	EXAMPLE 2:
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	STEP 1:
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	STEP 1:
Click Customize Menus to view the menu tree

	STEP 2:

[image: image24.emf]
	STEP 2:

Find the Patient Header. you will see two other options under this tab (Details and Select).  

This is where you will insert the Clear button.

	STEP 3:
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	STEP 3:
Click the [image: image26.png]


 button at the top of the menu to insert a new button. The new menu will display at the bottom of the list highlighted in blue.

	STEP 4:
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	STEP 4:
Use the [image: image28.png]


 and [image: image29.png]


 to move the new Clear button where you want it to display. I’m going to place mine above the Help menu item.
Use the [image: image30.png]


 to rename the button “Clear.”

	STEP 5:
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	STEP 5:

Highlight the new Clear button and click the [image: image32.png]


 to insert the following code: 

$(patient.clear)

Click OK and Apply to save the new feature. To test the new button, log out of Design Mode and test it.
If the new Clear works, log back into Design Mode and save it. See below for instructions on saving templates.


Adding Visit Brief Button

	STEP 1:

There is a new Visit Summary (Brief) Report available in Version 1.1 of the EHR. This report provides a more compact and readable alternative to the standard Visit Detail. The Visit Summary (Brief) Report can be printed for Release of Information. This report is available in the Reports window.
	STEP 1:
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	STEP 2:
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	STEP 2:
This report can be assigned to a button by following these instructions.

1. In Design Mode, add the Health Summary button to the Patient/Visit tool bar.
2. Right-click on the Health Summary Report button to display the Properties for Health Summary Report form

	Property

Value

Report

BEHOENPV:VISIT SUMMARY (BRIEF)~;;0^^1

Caption

Visit Summary (Brief)

Title

Visit Summary (Brief)

Asynchronous
False

Encounter Required
True


	STEP 3:

3. Enter the information from the table to the left in the Objects Properties field following information in the Value column of the Properties for Health Summary Report form
4. Save the template and exit Design Mode.

5. Select a patient and a visit that occurred after version 1.1 was installed.


Adding Visit Brief Button

STEP 1:

Assigning the Health Summary to a Button - Option A

This describes how to add the IHS Health Summary button to the Patient/Visit toolbar in the EHR.
EXAMPLE:
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	STEP 2:
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	STEP 2:

Follow these steps to assign the Health Summary to a button:

1. In Design Mode, add the Health Summary button to the Patient/Visit tool bar.

2. Right-click on the Health Summary Report button to display the properties.

3. In the Report field, enter IHS^X, where X is the unique DFN number for the type of Health Summary you are using. In this example, you would enter IHS^7 because 7 is the DFN. If you do not know the DFN number, go to the next section to find out how to retrieve it.

4. Enter the Health Summary Name in the Caption and Title fields.

5. Save the template and exit Design Mode.

6. Select a patient and view the health summary.


How to get the IEN Number of the Health Summary

          Enter or Edit File Entries
          Print File Entries
          Search File Entries
          Modify File Attributes
          Inquire to File Entries
          Utility Functions ...
          Data Dictionary Utilities ...
          Transfer Entries
          Other Options ...
 
Select VA FileMan Option: print File Entries
 
OUTPUT FROM WHAT FILE: HEALTH SUMMARY TYPE//
SORT BY: NAME// NUMBER
START WITH NUMBER: FIRST//
  WITHIN NUMBER, SORT BY:
FIRST PRINT FIELD: NAME
THEN PRINT FIELD: NUMBER

SORT BY: NAME//
START WITH NAME: FIRST//
FIRST PRINT FIELD: NUMBER
THEN PRINT FIELD: NAME
THEN PRINT FIELD:
Heading (S/C): HEALTH SUMMARY TYPE LIST  Replace
DEVICE:     Right Margin: 80//
HEALTH SUMMARY TYPE LIST                      JUL 25,2005  06:56    PAGE 1
NUMBER        NAME
----------------------------------------------------------------------------

7            ADULT REGULAR
73            ALLERGIES
91            AMBULANCE

Assigning the Health Summary to a Button – Option B

This describes how to add the VA Health Summary button to the Patient/Visit toolbar in the EHR.
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How to get the DFN Number of the Health Summary
         Enter or Edit File Entries
         Print File Entries
         Search File Entries
         Modify File Attributes
         Inquire to File Entries
         Utility Functions ...
         Data Dictionary Utilities ...
         Transfer Entries
         Other Options ...

Select VA FileMan Option: PRINT File Entries

OUTPUT FROM WHAT FILE: PROVIDER// VA HEALTH SUMMARY TYPE                                       (19 entries)
SORT BY: NAME//
START WITH NAME: FIRST//
FIRST PRINT FIELD: NUMBER
THEN PRINT FIELD: NAME
THEN PRINT FIELD:
Heading (S/C): VA HEALTH SUMMARY TYPE LIST  Replace
DEVICE:

VA HEALTH SUMMARY TYPE LIST                    SEP 25,2009  08:26    PAGE 1
NUMBER                          NAME                           
--------------------------------------------------------------------------------
54                                      MEDICATION PROFILE 
57                                      AIMS  


Adding Pharm Ed Button

Medication Counseling Button Setup
The RPMS-EHR application contains the Pharmacy Refill Counseling macro, which is available to be placed on the pharmacist’s VueCentric template. The macro enables rapid visit creation and documentation of Purpose of Visit and Patient Education for high volume workflow situations, such as dispensing medication refills.
The macro is launched from the Pharmacy Ed button in the Patient-Visit Toolbar. [image: image38.png]PhamEd
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	STEP 1:
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	STEP 1:

1. Clear a space on the Patient/Visit toolbar for the new Pharmacy Ed button

2. Right click in the blank spot and select Add Object

	STEP 2:
[image: image41.png]=0l

Helh Foctors A
Hoath Sumsy epot

10D Fick it

Inge

Inmurizaions

Inegiated Signate Tocl

Intemet Expter

- Legend
© Appiication Template:
© Object

© Stock Object

© Template.

© User Configuration
X Disabled

Lab Orcrs
Lab Resuls
Label

Medication Management
Medications

Message Broadcast
Notfications.

Orders (CPRS)

Panel

Ptient Mot Vi

Add

Cancel





	STEP 2:
1. Click the plus sign (+) in front of the name folder.
2. Scroll down the list of objects until you find the “Medication Counseling” Object and then click Add.



	STEP 3:
The button will display on your screen.
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	STEP 4:
1. To align to the button in the blank area, right-click and select Align.

2. Another option will appear. Select the alignment that will work for your space. 

3. In my example, I selected Right.
4. The button will fall into the space.
5. Save the changes you made to the template before exiting.
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Lab Point of Care Entry Button 

Use the Lab Point of Care feature by first adding the Lab Point of Care button on the toolbar. Follow these steps: 

1. After you access the EHR, go into Design Mode. 

2. Right-click in the area where you want to add the POC Entry button (somewhere in the toolbar is suggested). Select the Add an Object option in the context menu. 

3. The Add an Object window will display.
[image: image45.emf]
4. Expand Name in the Objects group box. Select the Lab Point of Care Data Entry option. Click Add. 
Setup Guide Point of Care Lab July 2009 13 Electronic Health Record (EHR) v1.1 Patch 5 

5. The POC Lab Entry button will display in the toolbar. Resize the button if necessary.
[image: image46.emf]
6. Select Design | Save As Template. 

7. Save and exit from Design Mode. 

The POC Lab Entry button requires that a visit and patient be selected before it becomes active.
Adding another Tab to EHR
	STEP 1:

[image: image47.png]Properties for Tabbed Notebook

Property Value I
ToP o
LEFT g
HEIGHT 27
WIDTH =
ALIGN O
ANCHORS [ Top: Lef;Right; Botiom
FIXEDWIDTH ¥ T
MULTILINE ¥ T
TABPOSITION Ton
TABSTYLE Sinle Slart
Tab Editor +-—cMmE|8%

X Carcel By Aol





	Go to the Patient Chart tab.

Right click on any of the tabs at the bottom and bring up the dialog box.

Choose the Tab Editor Button under Properties.

	STEP 2: 
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	STEP 2: 
Review the tabs, and using the + to add a tab, make a tab and name it “Test Tab.”

1. Add a tab

2. Name it “Test Tab”
Using the [image: image49.png]


 and [image: image50.png]


 arrows to rearrange the tab order.

Use the [image: image51.png]


 to rename the tab.

	STEP 3: 
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	STEP 3:
Go to the new test tab that you created.

Right-click on the middle of the tab and choose the option to add an object.
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	STEP 4:
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	STEP 4:
Click on the + sign beside the Name folder

Scroll down until you find the object named Splitter Pane.

	STEP 5: 
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	STEP 5:
Right-click and select Align.

Click Align All.

Right-click on the splitter pane and choose Properties.

	STEP 6:
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	STEP 6:

Change this splitter pane to Vertical instead of Horizontal.

Click Apply and Ok to see the changes

	STEP 7:
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	STEP 7:

Next, right-click on the top half of the splitter screen and choose Add Object.

Add the object named Reproductive History and align it to All.

Add the object named Immunizations to the bottom half and again align it to All.


Inserting a Web Page

Option 1: Adding a Web Site to the Communications Tab.

	STEP 1:
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	STEP 1:

Go to the Communications tab.

Right-click on the left side that contains a list of items on the Communications tab.
Choose Properties.

	STEP 2: 
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	STEP 2:
Here you can add a border, icon, and change the orientation.

Click Node Editor under Properties.

	STEP 3: 
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	STEP 3:
Click the + button.

Add a new tab and name it Yahoo.

Click Apply and OK to add the Web site button.

	STEP 4:
Highlight the new tab and right-click on Add Object.

Add the object named Microsoft Explorer.




Click Object to add.
	STEP 4:
[image: image61.png]T 13 IHS-EHR (EHRC) ;

Fatient Chart_ | Commurication

MictoMeder
Offce Insite
RPMS
Broadcast
Yahoo

2 Add an Object

BEX]

|~ Objects

1HS SuperBil (bgo)

1HS Triage:

HS Tiiage Control (bgo)
HS Triage Summary (bgo)
1HS VCPT (bgo)

HS Visk Diagnosis - VPOV (bgo)
Inegrated Signature Tool
rternet Explorer

Lab Orcrs

Lab Resuls

Label

Medications

Medications (CPRS)
Message Broadcast
Notes (CPRS)
Notiications (CPRS)
Orders (CPRS)

~ ]

| Legend
© Appiication Template:
© Object

© Stock Object

© Template

© User Configuration
X Disabled

X Cancel

HAGERMARY G democisnformaticscom | TUBACITYHO || DesianMode | 22Gep-2004 2341






	STEP 5:
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	STEP 5:
After the object is added, right-click on the object and select Align to All.

	STEP 6:
Right-click in the Internet Explorer box and choose Properties.

Enter the homepage of Yahoo.
	STEP 6:
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Option 2: Group Bar

	EXAMPLE:
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	STEP 1:
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	STEP 1:

Create a blank tab.

Go to the new tab.

Right-click in the middle of the blank tab.

Click Add an Object.

Find and click the Group Bar.

Click Add.

	STEP 2: 
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	STEP 2:

Right-click in the middle of the Group Bar.
Click Properties.

	STEP 3:
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	STEP 3:
You can change the border, orientation, style, etc.

	STEP 4:

Click the Group Editor under Property.

You will see the name of generic titles and links.
	STEP 4:
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	STEP 5:
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	STEP 5:
Highlight the Generic Group Name and Use the [image: image70.png]


 to rename the tab to Clinical Websites.

Using the [image: image71.png]


 and [image: image72.png]


 arrows to rearrange the tab order.

Click Apply and OK to make the changes.

	STEP 6:
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	STEP 6:
Click on the Up-to-Date Link in the Group Bar.

Right-click in the middle of the blank page and click Add Object.

	STEP 7:
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	STEP 7:
Find and Click the Internet Explorer Object.

Click Add.

	STEP 8:
[image: image75.png]& IHS-EHR MOORE,LORI B PHARM

User Design Patiert Toos Hel

{PatientChart | Communication

Demo.Dema

999990 01-Jan-1900 (107)M

Clinical Website (&)
Up-To-Date

General Website 2)
Yahoo

Up-To-Date

Visit not selected
MOORE LORIB PHARM

Back

Forward

Stop

Pefresh| Home | Print

Delete Objects.
Lock
Remove

) Interet Explorer Actions:

Anchor

Properties...

About,

I ¢

b Top
Bottom
Left
Right

Center

Privacy | Noffications

New Patient Data | Labs | Consults | Reports | D/CSumm | TestTab |





	STEP 8:
Right-Click in the middle of the Internet Explorer Object.

Select Align All.

	STEP 9:
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	STEP 9:

Right-cick in the middle of the Internet Explorer Object.
Click Properties.

	STEP 10:
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	STEP 10:
In the ALLOWNEWWINDOW, check the False box, making it True.
In the HOMEPAGE, type in the web address: http://www.uptodateonline.com/utd/index.do

	STEP 11:
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	STEP 11:
To test the Web page, exit Design Mode.
You Web page should automatically load.
You will need to log back into Design Mode to save the changes. See below for directions.


Adding Other RPMS Packages to EHR GUI

You can add other RPMS programs like Patient Chart, Behavioral Health GUI, and Clinical Scheduling GUI.
	EXAMPLE:
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	STEP 1:
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	STEP 1:

Create a new tab or a new link in the Group Bar
Name the link after the RPMS program you wish to insert (i.e. Clinical Schedule).

Click the Group Editor tab.

	STEP 2:
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	STEP 2:

Use the [image: image82.png]


 to rename the tab to Clinical Web sites.

Using the [image: image83.png]


 and [image: image84.png]


 arrows to rearrange the tab order.

Click Apply and OK to make the changes.

	STEP 3:
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	STEP 3:
Right-click in the middle of the blank page and click Add Object.

	STEP 4:
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	STEP 4:
Find and click the Program Launcher Object.

Click the Add button to insert the object.

	STEP 5:
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	STEP 5:

You will see a blank box in the middle of the screen.
Right-click in the middle of the box and select Properties.

	STEP 6:
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	STEP 6:
In the Properties box find the Caption Property.
Type in the name of the program.
Recommendation: Type “Click Here.”

	STEP 7:
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	STEP 7:
In the Properties box find the EXENAME.

Type the pathway to the RPMS program that you want to insert.

NOTE: make sure this program is installed on server.


Split Screens for Departments Using Both EHR and RPMS
(i.e. Pharmacy, Lab, Radiology, Data Entry, and Billing)
Pharmacy and Notes Tab
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Lab and Orders Tab
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Adding Facility Logo or Other JPG Picture to EHR

	EXAMPLE:
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	STEP 1:
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	STEP 1:

Create a new tab or use the Privacy tab to add the Icon Object.
Once tab has been created, right-click in the middle of the blank tab.
Click Add Object.
Find the object called Icon and click Add.

	STEP 2:
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	STEP 2:

In the blank Icon Box, right-click and select Properties.
In the Properties for an icon, add the pathway for your JPG image into the file name.
NOTE: place the image on a server where it can be accessed at all times.
Click OK to insert your image onto the tab.

	STEP 3:
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	STEP 3:
Your image may need to be resized.
Once finished, be sure to save the template. See below for instructions on saving templates.


Saving the New EHR GUI Template

Go to the Design drop-down menu and choose Save as Template.

[image: image96.png]Can save the changes




You can make a new template to be used or you can overwrite the template that you have selected.
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Do not overwrite the templates that come with the EHR.

Make new templates to use at your site.
Adding Quick Note to EHR

The Quick Note component can be added to an EHR template in the tool bar for access at any time. The component is called TIU Quick Note.
[image: image98.emf]
Chart Review Button:

[image: image99.emf]
The label on the “button” area below the component (for example Nds Rvwd below Problem List) can be configured. This also applies to the hover help that displays when you run your mouse over the button area. 

These features are on the Properties for Chart Review (done in Design Mode in the EHR GUI).
[image: image100.emf]
The property REVIEWEDCAPTION determines the label on the “button” area. 

The property REVIEWEDHINT determines the hover help wording. 

Below show the label and hover help in the application.
[image: image101.emf]
Rx Print Format (Template) Editor Set Up 
Use the Rx Print Format (Template) Editor Set Up to add the Rx Template Editor to an EHR template. Follow these steps: 

 Select Design mode | Desktop Properties | Customize Menus 
 Add Menu item Rx Template Editor 

Optionally, add a Print Rx menu with Rx Template Editor and Rx Print Config as submenus 

Add the following in Action (lightning bolt): 

$(BEHRXGENERATORSERVICE.RXGENERATOR.edittemplates)
[image: image102.emf]
Click Apply and OK (on Properties for Desktop). 

Make sure the BEH Rx Generator Service is checked under Required Services in Design Mode. Click on Design Mode | Design | Required Services.
[image: image103.emf]
Rx Printer Preferences Editor Set up 
Follow these steps: 

Select Design mode | Desktop Properties | Custom Menus. 

Add Menu item Rx Printer Config (Figure D- 1). 

Optionally, you can add a Print Rx menu with the Rx Template Editor and Rx Printer Config as submenus 

Add the following in Edit Action (lightning bolt): 

$(BEHRXGENERATORSERVICE.RXGENERATOR.EditPrinterPreference)

[image: image104.emf]
Click Apply and OK on the Properties for Desktop dialog. 

Make sure to have BEH Rx Generator Service checked under Required Services.
[image: image105.emf]
Users without the BEHORX PRINT key will only be able to set their own defaults. 
If the site does not want users to be able to set their own defaults, only add this menu option to EHR GUI templates for those users who are allowed to set this parameter. 

 Assign the BEHORX PRINT key for CAC/IT staff who will set Location, Division, System settings. 

[image: image106.emf]
For more detail setups, please refer to EHR Patch 9 Setup Guide.
Assigning New EHR GUI Template to Users
Select IHS Core Option: ehr  EHR SETUP MENU
   TIU    TIU Menu for Medical Records ...
   BEHO   IHS-EHR Configuration Master Menu ...
   CON    Consult Management ...
   CPRS   CPRS Manager Menu ...
   HS     Health Summary Maintenance ...
   REM    Reminder Managers Menu ...
   TIU1   TIU Menu for Clinicians ...
   VAHS   Health Summary Overall Menu ...
   XX     General Parameter Tools ...

Select EHR SETUP MENU Option: xx  General Parameter Tools
   LV     List Values for a Selected Parameter
   LE     List Values for a Selected Entity
   LP     List Values for a Selected Package
   LT     List Values for a Selected Template
   EP     Edit Parameter Values
   ET     Edit Parameter Values with Template
   EK     Edit Parameter Definition Keyword

Select General Parameter Tools Option: ep  Edit Parameter Values
                         --- Edit Parameter Values ---

Select PARAMETER DEFINITION NAME: CIAVM DEF
     1   CIAVM DEFAULT SOURCE     Default object source path
     2   CIAVM DEFAULT TARGET     Default installation path
     3   CIAVM DEFAULT TEMPLATE     Default login template
CHOOSE 1-3: 3  CIAVM DEFAULT TEMPLATE   Default login template

CIAVM DEFAULT TEMPLATE may be set for the following:

     100 User          USR    [choose from NEW PERSON]
     200 Class         CLS    [choose from USR CLASS]
     300 Service       SRV    [choose from SERVICE/SECTION]
     400 Location      LOC    [choose from HOSPITAL LOCATION]
     500 Division      DIV    [choose from INSTITUTION]
     900 Package       PKG    [VUECENTRIC FRAMEWORK]

Enter selection: 100  User   NEW PERSON
Select NEW PERSON NAME: MOORE,LORI
     1   MOORE,LORI B CLINICAL       LBM          167LBM     CLINICAL PHARMACIST
     2   MOORE,LORI B PHARM       LBM     119     109LBM     PHARMACIST
CHOOSE 1-2: 2  MOORE,LORI B PHARM     LBM     119     109LBM     PHARMACIST

-------- Setting CIAVM DEFAULT TEMPLATE for User: MOORE,LORI B PHARM -------
Default Template: %LORI// ??
   Choose from:
   $1983
   %AAO DEFAULT TEMPLATE
   %AAO LAB TEMPLATE
   %AAO PHARM TEMPLATE
   %CIH PROVIDER1
   %CIH PROVIDER2
   %DEFAULT
   %EHR_PROVIDER
   %EHR_QUICK ORDER WIZARD
   %LORI
   %PCC OBJECTS BGO
   %PROVIDER
   %PROVIDER NOTE
   %PROVIDER TEMPLATE
   %PROVIDER TEMPLATE2
   %PROVIDER3
   %PROVIDER3 NURSE
   %SFIH
   %SFIH CAC
   %SFIH LAB
   %SFIH LAB 2
   %SFIH MIDW 2
   %SFIH NURSE
   %SFIH OPT
   %SFIH PHARM
   %SFIH PROV 2
   %SFIH PROV 2_CAC

CHOOSE 1-10: 10  %SFIH PROV 2_CAC

Select PARAMETER DEFINITION NAME: ^
   LV     List Values for a Selected Parameter
   LE     List Values for a Selected Entity
   LP     List Values for a Selected Package
   LT     List Values for a Selected Template
   EP     Edit Parameter Values
   ET     Edit Parameter Values with Template
   EK     Edit Parameter Definition Keyword

Select General Parameter Tools Option: LV  List Values for a Selected Parameter
Select PARAMETER DEFINITION NAME: CIAVM DEFAULT TEMPLATE   Default login template

Values for CIAVM DEFAULT TEMPLATE

Parameter                      Instance             Value
----------------------------------------------------------------------------
DIV: SANTA FE HOSPITAL         1                    %SFIH PROV 2
USR: DUONG,QUYNH-CHI TAN PHARM 1                    %SFIH PROV 2_CAC
CLS: LABORATORY TECHNICIAN     1                    %SFIH LAB 2
USR: MOORE,LORI B PHARM        1                    %SFIH PROV 2_CAC
CLS: OPTOMETRIST               1                    %SFIH OPT
CLS: PHARMACIST                1                    %SFIH PHARM
CLS: PHARMACY STUDENT          1                    %SFIH PHARM
CLS: PHARMACY TECHNICIAN       1                    %SFIH PHARM
PKG: VUECENTRIC FRAMEWORK      1                    %DEFAULT
CLS: CLINICAL PHARMACIST       1                    %SFIH PROV 2
CLS: OPTOMETRIST TECH          1                    %SFIH OPT
CLS: OPTOMETRY STUDENT         1                    %SFIH OPT

Importing/Exporting EHR GUI Templates to Other Facilities

	STEP 1:
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	STEP 1:

Log into VC Manager using the same access and verify code for EHR/RPMS.

	STEP 2:
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	STEP 2:

Click on the Template Registry tab.
This is a list of all the templates in your EHR.

	STEP 3:

[image: image109.png]£ VueCentric System Management [161.223.162.1 - SFH]

N N N

%EHR_QUICK DRDER WIZARD
ZL0RT

%PCC OBJECTS BGO
%PROVIDER
%PROVIDER NOTE
%PROVIDER TEMPLATE
%PROVIDER TEMPLATE2
%PROVIDER3
%PROVIDER NURSE
PN

%FIH CAC

ZSFIHLAR

%SFIHLAE 2
ZSFIHMIDW 2

%SFIH NURSE

%SFIH OPT

%SFIH PHARM

%SFIH PROV 2

HEADER





	STEP 3:

To export an EHR GUI template, click on the template that you are going to export.
Click on File and Export.

	STEP 4:
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	STEP 4:

Assign the template a name and save it.
Attach file to an email and forward to another site.
To import the template, you will need to save it to your computer and import it using the same steps.





This option should only be placed on the EHR GUI template for those responsible for editing these format, for example, the CAC, and designated pharmacy personnel.











